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1.	Einführung
Sehr geehrte Kundin, sehr geehrter Kunde,
Vielen Dank für den Kauf dieses Produkts.
Dieses Produkt erfüllt die gesetzlichen nationalen und europäischen Anforderungen.
Um diesen Status zu erhalten und einen sicheren Betrieb zu gewährleisten, müssen Sie als Anwender diese 
Betriebsanleitung beachten!

	 Diese Bedienungsanleitung ist Teil dieses Produkts. Sie enthält wichtige Hinweise zur Inbetriebnahme und 
Handhabung. Bedenken Sie dies auch, wenn Sie das Produkt an Dritte weitergeben. Bewahren Sie diese 
Bedienungsanleitung daher zu Nachschlagezwecken auf!

Bei technischen Fragen wenden Sie sich bitte an:
Deutschland:	 www.conrad.de/kontakt
Österreich:	 www.conrad.at
	 www.business.conrad.at
Schweiz:	 www.conrad.ch
	 www.biz-conrad.ch

2.	Symbol-Erklärungen
	 Das Symbol mit dem Ausrufezeichen im Dreieck weist auf wichtige Informationen in dieser 

Bedienungsanleitung hin. Lesen Sie diese Informationen immer aufmerksam.

	 Das Pfeilsymbol weist auf besondere Informationen und auf Ratschläge zur Bedienung hin. 

3.	Bestimmungsgemäße Verwendung
Das Produkt gibt über eine USB 2.0-Verbindung ein vergrößertes Bild an Ihren Computer aus und eignet sich für die 
Untersuchung von festen Objekten wie Münzen, Briefmarken, Steine, Insekten, Pflanzen, Textilien, Leiterplatten usw. 
Dimmbare eingebaute LED-Leuchten sorgen für Helligkeit und die im Lieferumfang befindliche Software erlaubt dem 
Benutzer, das Mikroskop zu kalibrieren, gespeicherte Bilder zu bearbeiten und zu messen. 
Das Gerät ist nur für den Innengebrauch geeignet. Nicht im Freien verwenden. Der Kontakt mit Feuchtigkeit, z. B. im 
Badezimmer, ist unbedingt zu vermeiden.
Aus Sicherheits- und Zulassungsgründen dürfen Sie dieses Produkt nicht umbauen und/oder verändern. Falls Sie das 
Produkt für andere als die zuvor genannten Zwecke verwenden, könnte das Produkt beschädigt werden. Darüber hinaus 
kann eine unsachgemäße Verwendung zu anderen Gefahren führen. Lesen Sie sich die Bedienungsanleitung genau durch 
und bewahren Sie diese auf. Reichen Sie das Produkt nur zusammen mit der Bedienungsanleitung an dritte Personen weiter.
Alle enthaltenen Firmennamen und Produktbezeichnungen sind Warenzeichen der jeweiligen Inhaber. Alle Rechte vorbehalten.
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4.	Lieferumfang
•	 Hauptgerät mit USB-Kabel
•	 Standfuß
•	 Software-CD
•	 Kalibrierlineal
•	 Schnellstartanleitung
•	 Wichtige Informationen
•	 Bedienungsanleitung

Aktuelle Bedienungsanleitungen            
Laden Sie aktuelle Bedienungsanleitungen über den Link www.conrad.com/downloads herunter 
oder scannen Sie den abgebildeten QR-Code. Befolgen Sie die Anweisungen auf der Webseite.

5.	Eigenschaften und Funktionen
•	 20 x – 300 x variable Vergrößerung
•	 Kamera: 5,0 Megapixel (Hardwareauflösung)
•	 Fokusbereich 10 - 100 mm 
•	 Video-Bildrate 30 fps
•	 8 x LED / einstellbare Helligkeit (max. 500 Lux)
•	 mit Windows® und MacOS kompatibel
•	 Software: MicroCapture Plus

6.	Systemvoraussetzung
•	 Betriebssystem: Windows® 7/8/10; Mac OS 10.12 oder höher
•	 CPU: Pentium 300 oder kompatibler AMD-Prozessor 
•	 100 MB freier Festplattenspeicher
•	 512 MB RAM
•	 24-Bit-Grafikkarte
•	 Freier USB 2.0-Anschluss
•	 CD-ROM-Laufwerk
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7.	Sicherheitsanweisungen
Lesen Sie die wichtigen Informationen und die Bedienungsanleitung sorgfältig durch und beachten 
Sie insbesondere die Sicherheitshinweise. Falls Sie die Sicherheitshinweise und Informationen 
für einen ordnungsgemäßen Gebrauch in dieser Bedienungsanleitung nicht beachten, haften 
wir nicht für möglicherweise daraus resultierende Verletzungen oder Sachschäden. Außerdem 
erlischt in solchen Fällen die Gewährleistung/Garantie.

a)	Allgemein
•	 Das Produkt ist kein Spielzeug. Halten Sie es von Kindern und Haustieren fern.
•	 Lassen Sie das Verpackungsmaterial nicht achtlos liegen. Dieses könnte für Kinder zu einem 

gefährlichen Spielzeug werden.
•	 Schützen Sie das Produkt vor extremen Temperaturen, direkter Sonneneinstrahlung, starken 

Erschütterungen, hoher Luftfeuchtigkeit, Feuchtigkeit, brennbaren Gasen, Dampf und Lösungsmitteln.
•	 Setzen Sie das Produkt keiner mechanischen Beanspruchung aus.
•	 Wenn kein sicherer Betrieb mehr möglich ist, nehmen Sie das Produkt außer Betrieb und schützen Sie es vor 

unbeabsichtigter Verwendung. Der sichere Betrieb ist nicht mehr gewährleistet, wenn das Produkt:
-- sichtbare Schäden aufweist, 
-- nicht mehr ordnungsgemäß funktioniert 
-- über einen längeren Zeitraum unter ungünstigen Umgebungsbedingungen gelagert wurde oder 
-- erheblichen Transportbelastungen ausgesetzt wurde.

•	 Gehen Sie vorsichtig mit dem Produkt um. Stöße, Schläge oder sogar das Herunterfallen aus geringer 
Höhe können das Produkt beschädigen.

•	 Beachten Sie auch die Sicherheitshinweise und Bedienungsanleitungen der übrigen Geräte, an die das 
Produkt angeschlossen wird.

•	 Wenden Sie sich an einen Experten, wenn Sie Zweifel an der Funktion, Sicherheit oder in Bezug auf den 
Anschluss des Produkts haben.

•	 Wartung, Modifikationen und Reparaturen dürfen nur von einem Techniker oder einer autorisierten 
Reparaturwerkstatt durchgeführt werden.

•	 Sollten Sie noch Fragen haben, die in dieser Bedienungsanleitung nicht beantwortet werden, wenden 
Sie sich an unseren technischen Kundendienst oder an andere Fachleute.

•	 Achtung, LED-Licht:
-- Nicht direkt in das LED-Licht blicken!
-- Nicht direkt oder mit optischen Instrumenten in den Strahl sehen!

•	 In Schulen, Ausbildungsstätten, Hobby- oder Selbstbedienungswerkstätten muss der Umgang mit 
elektrischen Geräten durch geschultes Personal überwacht werden.

•	 Bei Betrieb in gewerblichen Einrichtungen sind die einschlägigen Unfallverhütungsvorschriften der 
Berufsgenossenschaften für elektrische Betriebsmittel zu beachten.



6

b)	Mikroskop
•	 Untersuchen Sie keine Objekte, die Temperaturen außerhalb des angegebenen Betriebstemperaturbereichs 

des Produkts aufweisen.
•	 Plötzliche Temperaturänderungen können dazu führen, dass sich im Inneren des Mikroskops Tau bildet 
– wie im kalten Winter in einen warmen Raum. Legen Sie es in eine Handtasche oder eine Plastiktüte, 
um Temperaturänderungen zu verlangsamen.

•	 Richten Sie das Objektiv des Mikroskops nicht lange auf die Sonne oder starkes Licht. Starkes Licht 
kann die lichtempfindliche Elektronik beschädigen.

•	 Setzen Sie die Karte nicht mit Gewalt in den Steckplatz ein, da dies das Mikroskop und die microSD-
Speicherkarte beschädigen kann. 

•	 Der Standfuß des Mikroskops kann Spuren auf empfindlichen Oberflächen hinterlassen.

c)	Kabel
•	 Stellen Sie sicher, dass beim Aufstellen das Kabel nicht gequetscht, geknickt oder durch scharfe Kanten 

beschädigt wird.
•	 Verlegen Sie Kabel immer so, dass niemand über diese stolpern oder an ihnen hängen bleiben kann. 

Es besteht Verletzungsgefahr.

d)	Schutz vor Staub
•	 Staub und Ablagerungen aus der Luft können zu einer Verschlechterung der Bildqualität führen. Halten 

Sie das Mikroskop von staubigen Umgebungen fern.
•	 Die Öffnung des Kameraobjektivs sollte immer entweder mit Staubschutzhauben o. ä. bedeckt werden. 

Geeignete Optionen sind z. B. Aluminiumfolie oder Plastikbeutel.
•	 Wenn dunkle Flecken oder ähnliche Partikel auf den digitalen Bildern zu sehen sind und diese sich nicht 
Probenplatte befinden, ist die wahrscheinlichste Ursache dafür eine Partikelverunreinigung auf dem 
Bildsensor oder einer zugeordneten Filteroberfläche. Die Kameras müssen nach den Empfehlungen des 
Herstellers immer mit größter Sorgfalt behandelt und vor Verschmutzung geschützt werden.

•	 Überprüfen Sie vor jedem Einsatz die Frontlinse des Objektivs auf Verschmutzung.
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8.	Bedienelemente
A1

A2

A3 A4 A6

A5

A7
A8

A10

A11

A12
A13

A9

A1	 USB-Kabelführung
A2	 LED Helligkeitsregelung
A3	 Verriegelung des Grobfokussierens
A4	 Grobfokussierrad
A5	 Verriegelung des Mikroskophalters
A6	 Feinfokussierrad
A7	 LED-Lichtquelle / Kameraobjektiv

A8	 Halter mit Halterclips
A9	 USB 2.0 Typ-A-Kabel
A10	 Arretierung der Armhöhenverstellung
A11	 Säule
A12	 Befestigungsschraube der Säule
A13	 Standfuß

9.	Einrichten des Mikroskops
	 Nehmen Sie das Mikroskop vorsichtig aus der Verpackung und stellen Sie es auf einer stabilen, flachen 
Oberfläche auf. Der Standfuß kann Spuren auf empfindlichen Oberflächen hinterlassen. Stellen Sie sicher, 
dass die Säule (A11) vollständig eingesetzt und mit der Säulenbefestigungsschraube (A12) gesichert ist.
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10.	Scharfstellen des Mikroskops
	 Decken Sie das Mikroskop nicht ab, wenn es in Gebrauch ist.

•	 Legen Sie das zu untersuchende Objekt auf die Ablage (A8) . Wenn Sie Dias oder ähnliches anschauen wollen, 
befestigen Sie sie mit den Clips auf der Ablage. 

•	 Halten Sie das Grobfokussierrad (A4) fest und lösen Sie die Verriegelung des Grobfokussierens (A3).
•	 Drehen Sie das Grobfokussierrad (A4), um das Objektiv zum Objekt hin abzusenken.
•	 Stellen Sie das Feinfokussierrad (A6) ein, um das Bild scharf zu stellen.
•	 Abhängig von der Größe des Objekts müssen Sie möglicherweise die Armöhe anpassen, indem Sie die Arretierung 

der Armhöhenverstellung (A10) lösen, die Position anpassen und dann erneut festziehen.

	 Es kann einige Augenblicke dauern, bis der Weißabgleich sich automatisch einstellt und das Bild scharf 
stellt. Wenn das Objekt zu stark reflektiert, sollten Sie die LED-Helligkeit verringern (A2) oder vollständig 
ausschalten.
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11.	Verbindung des Mikroskops mit einem Computer
•	 Verbinden Sie das USB 2.0-Kabel des Mikroskops (A9) mit einem freien USB 2.0-Anschluss an Ihrem Computer.
•	 Sie können das lose Kabel an der USB-Kabelführung (A1) befestigen.

12.	Software-Installation
a)	Windows®

•	 Legen Sie die Installations-CD in das DVD-ROM-Laufwerk Ihres Computers ein.
•	 Wählen Sie MicroCapture Plus aus, um die Software zu installieren, und befolgen Sie dann die Anweisungen auf 

dem Bildschirm, um den Installationsvorgang abzuschließen.
•	 Führen Sie die Software aus, indem Sie auf das nach der Installation auf dem Desktop erstellte MicroCapture 

Plus-Symbol klicken.
•	 	� Ändern Sie ggf. die Anzeigesprache, z. B. Options (Optionen) > Language (Sprache) > English 

(Englisch).

b)	MacOS
•	 Legen Sie die Installations-CD in das DVD-ROM-Laufwerk Ihres Computers ein.
•	 Suchen Sie den Ordner Mac auf der Installations-CD. 
•	 Wählen Sie die Datei MicroCapture Plus.pkg aus.
•	 Befolgen Sie die Anweisungen auf dem Bildschirm, um den Installationsvorgang abzuschließen.
•	 Führen Sie die Software aus, indem Sie auf das nach der Installation auf dem Desktop erstellte MicroCapture 

Plus-Symbol klicken.
	� Ändern Sie ggf. die Anzeigesprache, z. B. Options (Optionen) > Language (Sprache) > English 

(Englisch).
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13.	MicroCapture Plus Software
a)	Übersicht

B1
B2

B3

B4

B5

B6

B7

B1	 Menüpunkte
-- File (Datei) > Photos oder Videos Folder (Foto- oder Video-Ordner): Ort der aufgenommenen Bilder
-- Options (Optionen) > Resolution (Auflösung): Ändern der Auflösung der aufgenommenen Bilder
-- Options (Optionen) > Date /Time (Datum/Uhrzeit): Ein-/Ausblenden des Datums-/Uhrzeitstempel auf einem 

Foto oder in einem Video
-- Options (Optionen) > Language (Sprache): Einstellen der Sprache für die Benutzeroberfläche
-- Options (Optionen) > XY Guide (XY-Hilfslinien): Hilfslinien anzeigen/ausblenden

B2	 Shortcuts: Kamera / Video / Timer / Vollbild

 
Wechseln Sie in den Vollbildmodus oder beenden Sie ihn, indem Sie auf den Vorschaubereich doppelklicken oder 
das Vollbild-Symbol auswählen.

B3	 X- und Y-Achsen-Hilfslinien
B4	 Bildvorschaubereich
B5	 Vergrößerungsinformationen
B6	 Foto/Video-Registerkarte: Wählen Sie eine Registerkarte aus, um gespeicherte Fotos oder Videos anzuzeigen.
B7	 Fenster für gespeicherte Bilder (Miniaturansicht)

-- Aufgenommene Bilder/Videos werden als Miniaturansichten angezeigt.
-- Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaubereich angezeigt (B4).
-- Klicken Sie mit der rechten Maustaste auf ein Bild, um weitere Optionen anzuzeigen, z. B. Open (Öffnen), Save 

as (Speichern unter), Copy (Kopieren), Delete (Löschen), Delete All (Alle löschen).
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b)	Fotos aufnehmen 
•	 Stellen Sie das Mikroskop so ein, dass das Kameraobjektiv (A7) nahe am Objekt liegt und auf dieses zeigt.
•	 Stellen Sie sicher, dass sich das zu untersuchende Objekt unter dem Objektiv befindet.
•	 Während Sie den Bildvorschaubereichs (B4) betrachten, stellen Sie das Bild scharf.

•	 Um ein Bild aufzunehmen, wählen Sie den Kamera-Shortcut  oder drücken Sie die Schnappschuss-Taste.
•	 Die Fotos werden in File (Datei) > Photos Folder (Fotoordner) gespeichert.

	 Aufgenommene Bilder werden als Miniaturansichten im Fenster für gespeicherte Bilder angezeigt (B7). 
Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaufenster angezeigt. 
Bilder werden im JPG-Format gespeichert.

c)	Videos aufnehmen
•	 Stellen Sie das Mikroskop so ein, dass das Kameraobjektiv (A7) nahe am Objekt liegt und auf dieses zeigt.
•	 Stellen Sie sicher, dass sich das zu untersuchende Objekt unter dem Objektiv befindet.
•	 Während Sie den Bildvorschaubereichs (B4) betrachten, stellen Sie das Bild scharf.

•	 Um mit der Aufnahme zu beginnen, klicken Sie auf den Video-Shortcut . Das Symbol blinkt, um anzuzeigen, 
dass die Aufnahme gestartet wurde.

•	 Klicken Sie auf das blinkende Symbol, um die Aufzeichnung zu stoppen.
•	 Videos werden in File (Datei) > Photos Folder (Videoordner) gespeichert.

	 Aufgenommene Videos werden als Miniaturansichten im Fenster für gespeicherte Bilder angezeigt (B7). 
Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaufenster angezeigt. 
Videos werden im AVI-Format gespeichert.

d)	Foto- und Video-Timer

.

•	 Sie können einen benutzerdefinierten Start- und Stopptimer für die Aufnahme 
von Fotos oder Videoaufnahmen einstellen.

•	 Wählen Sie das Timer-Shortcut-Symbol  aus und wählen Sie dann Photo 
(Foto) oder Video.

•	 Nehmen Sie die gewünschten Einstellungen vor.
•	 Wählen Sie Start aus, um mit der Aufnahme zu beginnen.

	 Die Aufnahme stoppt, nachdem das Programm die Parameter 
durchlaufen hat oder wenn Sie Stop (Stopp) wählen, um den Timer zu 
beenden.
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e)	Bildmesswerkzeuge
 Um die Genauigkeit der Messwerkzeuge sicherzustellen, kalibrieren Sie zuerst Ihr Mikroskop. Informationen 
dazu finden Sie im Abschnitt „Kalibrieren des Mikroskops“.

	 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder (B7), um auf das Menü zum Messen 
zuzugreifen, und wählen Sie dann das Symbol  zum Messen.

•	 Any Angle Line Measurement (Beliebige Winkellinienmessung). Klicken 
und ziehen Sie von einem Punkt zum anderen.

•	 Continuous Line Measurement (Kontinuierliche Linienmessung). 
Klicken und ziehen Sie von einem Punkt zu mehreren Punkten.

•	 Radius Circle Measurement (Radiuskreismessung). Klicken und ziehen 
Sie, um den Radius zu vergrößern.

•	 Diameter Circle Measurement (Durchmesserkreismessung). Klicken und 
ziehen Sie, um den Durchmesser zu vergrößern.

•	 Three Points Angle Measurement (Drei-Punkte-Winkelmessung). Klicken 
und ziehen Sie von einem Punkt zum anderen, messen Sie den Winkel, und 
klicken Sie dann mit der Maus, um loszulassen. 

f)	 Zeichnen und Text
	 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder (B7), um die Oberfläche für Bildmarkierung/

Kommentare aufzurufen, und wählen Sie dann das Symbol  zum Zeichnen aus.
•	 Ein Dropdown-Menü mit verschiedenen Optionen wird angezeigt.

•	 In den Line Properties (Linieneigenschaften) können Line Width 
(Linienbreite) und Line Color (Linienfarbe) angepasst werden.

•	 Wählen Sie das Text-Symbol  aus.
•	 Ein Dropdown-Menü mit verschiedenen Optionen wie Schriftart und 

Textfarbe wird angezeigt.
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14.	Kalibrieren des Mikroskops
•	 Fokussieren Sie das Mikroskop auf das Kalibrierungslineal.
•	 Drehen Sie den Feintrieb, bis das Bild scharf wird. 

•	 Stellen Sie die Position des Mikroskops ein, dass das 
Bild auf die XY-Hilfslinien ausgerichtet ist.

	 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder (B7) , um die um auf das Menü zum 
Messen zuzugreifen, und wählen Sie dann das Symbol  zum Kalibrieren.

•	 Klicken und ziehen Sie, um Start- und Endpunkte 
über einen bekannten Wert zu wählen, z. B. 1 mm-
Abschnitte auf dem Lineal.

•	 Wenn das Dialogfeld angezeigt wird, geben Sie den 
genauen Wert der Messprobe in das Feld Actual 
dimension (Tatsächliche Länge) ein. Die Software 
kalibriert die Vergrößerung. 

•	 Drücken Sie zur Bestätigung auf OK. Der eingestellte 
Vergrößerungswert wird in der oberen rechten Ecke 
angezeigt.
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15.	Starke und geringe Vergrößerung
•	 Hohe Vergrößerung (1,5 mm Sichtfeld): Drehen Sie das Feinfokussierrad (A6) ganz nach rechts und drehen Sie 

dann langsam zurück, bis das Bild scharfgestellt ist.
•	 Geringe Vergrößerung (6 mm Sichtfeld): Drehen Sie das Feinfokussierrad (A6) ganz nach rechts und drehen Sie 

dann langsam zurück, bis das Bild scharfgestellt ist.

	 Nachdem Sie den Feintrieb (A6) ganz nach rechts oder links gedreht haben, dauert es einige Sekunden, 
bis sich die LED-Beleuchtung wieder korrekt eingestellt hat.

16.	Pflege und Reinigung
•	 Trennen Sie das Produkt vor jeder Reinigung von Ihrem Computer. Wenn es heiß ist, warten Sie, bis es abgekühlt 

ist.
•	 Verwenden Sie keine aggressiven Reinigungsmittel, Alkohol oder andere chemischen Lösungsmittel, da diese zu 

Schäden am Gehäuse und zu Fehlfunktionen führen können.
•	 Die LED-Beleuchtung ist nicht austauschbar.
•	 Vermeiden Sie es, die Linse mit irgendwelchen Stoffen zu berühren. Reinigen Sie die Linse regelmäßig mit 

niedrigerer Druckluft.
•	 Verwenden Sie zum Reinigen des Produkts ein trockenes, faserfreies Tuch.

17.	Entsorgung
	 Elektronische Geräte sind recyclingfähig und dürfen nicht im Hausmüll entsorgt werden. Entsorgen Sie 

das Produkt am Ende seiner Lebensdauer gemäß den geltenden gesetzlichen Bestimmungen. Sie erfüllen 
damit die gesetzlichen Verpflichtungen und leisten Ihren Beitrag zum Umweltschutz.
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18.	Technische Daten
Betriebsspannung..............................................5 V / DC, 1 A (über USB 2.0)
Verbindung........................................................USB 2.0 (Typ A)
Bildsensor..........................................................5 MP (Hardwareauflösung)
Video / Standbildauflösung................................2592x1944, 2320x1744, 2048x1536, 1920x1080, 1280x1024 Pixel
Fokusbereich.....................................................0 mm bis 150 mm (manueller Fokus)
Vergrößerung.....................................................10 x – 300 x
Bildformat..........................................................JPG
Videoformat.......................................................AVI
Weißabgleich ....................................................Automat
Lichtquelle LED
Betriebsbedingungen..............................................0 bis +70° C, 25 bis 50 % relative Luftfeuchtigkeit (nicht kondensierend)
Lagerbedingungen..................................................-5 bis +50 °C, 25 bis 50 % relative Luftfeuchtigkeit (nicht kondensierend)
Unterstützte Betriebssysteme............................Windows® 7/8/10; Mac OS 10.12 oder höher
Abmessungen Kamera (Ø x L)..........................33 mm x 110 mm
Abmessungen Standfuß (L x B x H)..................165 x 118 x 12 mm 
Gewicht..............................................................1 kg
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1.	Introduction
Dear customer,
Thank you for purchasing this product.
This product complies with the statutory national and European requirements.
To maintain this status and to ensure safe operation, you as the user must observe these operating instructions!

	 These operating instructions are part of this product. They contain important notes on commissioning and 
handling. Also consider this if you pass on the product to any third party. Therefore, retain these operating 
instructions for reference!

If there are any technical questions, please contact:
International: 	 www.conrad.com/contact
United Kingdom: 	 www.conrad-electronic.co.uk/contact

2.	Explanation of Symbols
	 The symbol with the exclamation mark in the triangle is used to indicate important information in these 

operating instructions. Always read this information carefully.

	 The arrow symbol indicates special information and advice on operation. 

3.	Intended Use
The product outputs a magnified image to your computer via USB 2.0 connection and is suitable for examining solid 
objects such as coins, stamps, rocks, insects, plants, textiles, circuit boards, etc. Dimmable built-in LED lights provide 
brightness, and the bundled software allow the user to calibrate the microscope, edit and measure saved images. 
It is intended for indoor use only. Do not use it outdoors. Contact with moisture, e.g. in bathrooms, must be avoided 
under all circumstances.
For safety and approval purposes, you must not rebuild and/or modify this product. If you use the product for purposes 
other than those described above, the product may be damaged. In addition, improper use can result in other hazards. 
Read the instructions carefully and store them in a safe place. Make this product available to third parties only together 
with its operating instructions.
All company names and product names are trademarks of their respective owners. All rights reserved.
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4.	Delivery Content
•	 Main unit with USB cable
•	 Base
•	 Software CD
•	 Calibration ruler
•	 Quickstart guide
•	 Important information
•	 Operating instructions

Up-to-Date Operating Instructions            
Download the latest operating instructions at www.conrad.com/downloads or scan the QR code 
shown. Follow the instructions on the website.

5.	Features and Functions
•	 20x - 300x variable magnification
•	 Camera: 5.0 megapixels (true)
•	 Focus range 10 - 100 mm 
•	 Video frame rate 30 fps
•	 8 x LED / adjustable brightness (max. 500 lux)
•	 Windows®, Mac OS compatible
•	 Software: MicroCapture Plus

6.	System Requirements
•	 OS: Windows® 7/8/10; Mac OS 10.12 or above
•	 CPU: Pentium 300 or compatible AMD Processor 
•	 100 MB free hard disc space
•	 512 MB RAM
•	 24-bit video card
•	 Available USB 2.0 port
•	 CD-ROM drive
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7.	Safety Instructions
Read the important information and operating instructions carefully and especially observe 
the safety information. If you do not follow the safety instructions and information on proper 
handling, we assume no liability for any resulting personal injury or damage to property. Such 
cases will invalidate the warranty/guarantee.

a)	General
•	 The device is not a toy. Keep it out of the reach of children and pets.
•	 Do not leave packaging material lying around carelessly. This may become dangerous playing material 

for children.
•	 Protect the device from extreme temperatures, direct sunlight, strong jolts, high humidity, moisture, 
flammable gases, steam and solvents.

•	 Do not place the product under any mechanical stress.
•	 If it is no longer possible to operate the product safely, take it out of operation and protect it from any 

accidental use. Safe operation can no longer be guaranteed if the product:
-- is visibly damaged, 
-- is no longer working properly, 
-- has been stored for extended periods in poor ambient conditions or 
-- has been subjected to any serious transport-related stresses.

•	 Please handle the product carefully. Jolts, impacts or a fall even from a low height can damage the 
product.

•	 Also observe the safety and operating instructions of any other devices which are connected to the 
product.

•	 Consult an expert when in doubt about the operation, safety or connection of the device.
•	 Maintenance, modifications and repairs must only be completed by a technician or an authorised repair 

centre.
•	 If you have questions which remain unanswered by the operating instructions, contact our technical 

support service or other technical personnel.
•	 Attention, LED light:

-- Do not look directly into the LED light!
-- Do not look into the beam directly or with optical instruments!

•	 In schools, training facilities, hobby or self-service workshops, handling of electrical devices must be 
monitored by trained personnel.

•	 When operating on commercial premises, the relevant accident prevention regulations of workers’ 
compensation boards for electrical equipment must be observed.
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b)	Microscope
•	 Do not examine objects with temperatures outside the given operating temperature range of the product.
•	 Sudden temperature change may form dew inside the Microscope like entering a warm room in cold 

winter. Put it inside a handbag or plastic bag to slow down temperature changes.
•	 Do not point Microscope lens to the sun or strong light for a long time. Powerful light may damage the 

light-sensitive electronics.
•	 Do not force the card into the slot as this may damage the microscope and the MicroSD memory card. 
•	 The base of the microscope may leave marks on sensitive surfaces.

c)	Cable
•	 When setting up the product, make sure that the cable is not pinched, kinked or damaged by sharp 

edges.
•	 Always lay the cables so that nobody can trip over or become entangled in them. This poses a risk of 

injury.

d)	Protection Against Dust
•	 Dust and debris from the air can lead to deterioration of image quality. Keep the Microscope away from 

dusty environments.
•	 The opening of the camera lens should always be protected either with dust covers such. Suitable 

options include aluminium foil or plastic bags.
•	 If dark specks or similar in-focus artifacts are observed in digital images, and they are not in the specimen 
plane, their most likely cause is particulate contamination on the image sensor or an associated filter 
surface. The cameras always need to be handled with the utmost care and protected from dirt according 
to the manufacturer‘s recommendations.

•	 Before every critical use, check the front lens of the objective for dirt.
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8.	Operating Elements
A1

A2

A3 A4 A6

A5

A7
A8

A10

A11

A12
A13

A9

A1	 USB Cable guide
A2	 LED brightness adjuster
A3	 Coarse focus lock
A4	 Coarse focus dial
A5	 Microscope holder lock
A6	 Fine focus dial
A7	 LED light source / camera lens

A8	 Stage with stage clips
A9	 USB 2.0 Type-A cable
A10	 Arm height adjustment lock
A11	 Column
A12	 Column attachment screw
A13	 Base

9.	Setting Up the Microscope
	 Gently take the microscope out of the packaging and place onto a stable flat surface. The base of the stand 

may leave marks on sensitive surfaces. Make sure the column (A11) is fully inserted and secured using the 
column attachment screw (A12).
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10.	Focus the Microscope
	 Do not cover the microscope when it is in use.

•	 Place the object to be examined onto the stage (A8). If observing slides or similar, insert under the stage clips. 
•	 While holding the coarse focus dial in place (A4), release the coarse focus lock (A3).
•	 Rotate the coarse focus dial (A4) to lower the lens towards the object.
•	 Adjust the fine focus dial (A6) to bring the image into sharp focus.
•	 Depending on the size of the object, you may need to adjust the arm height by releasing the arm height adjustment 

lock (A10), adjusting the position, then tightening it again.

	 It may take a few moments for the white balance to auto adjust and bring the image into focus. If there is 
too much reflection from the object, consider lowering the LED brightness (A2) or turning it off completely.
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11.	Connect Microscope to Computer
•	 Connect the microscope USB 2.0 cable (A9) to an available USB 2.0 port on your computer.
•	 Tidy up the loose cable by clipping it into the USB cable guide (A1).

12.	Software Installation
a)	Windows®

•	 Insert the installation disc into your computer DVD-ROM drive.
•	 Select MicroCapture Plus to install the software, then follow the on-screen instructions to complete the installation 

process.
•	 Run the software by clicking the MicroCapture Plus icon generated on the desktop after installation.

	 If needed change the display language e.g. Options > Language > English.

b)	Mac OS
•	 Insert the installation disc into your computer DVD-ROM drive.
•	 Find the folder on the installation disc named Mac. 
•	 Select the file MicroCapture Plus.pkg file.
•	 Follow the on screen instructions to complete the installation process.
•	 Run the software by clicking the MicroCapture Plus icon generated on the desktop after installation.

	 If needed change the display language e.g. Options > Language > English.
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13.	MicroCapture Plus Software
a)	Overview

B1
B2

B3

B4

B5

B6

B7

B1	 Menu items
-- File > Photos or Videos Folder: Captured images location.
-- Options > Resolution: Change image capture resolution.
-- Options > Date /Time: Show/hide the recorded date and time in photo or video.
-- Options > Language: Change user interface language.
-- Options > XY Guide: Show/hide guidelines.

B2	 Shortcuts: Camera / Video / Timer / Full Screen.

 
Enter / exit full screen mode by double-clicking the preview area or selecting the full screen icon.

B3	 X and Y axis guidelines.
B4	 Image preview area.
B5	 Magnification information.
B6	 Photo / Video tab: Select a tab to view saved Photos or Videos.
B7	 Saved images window (thumbnail view).

-- Captured images / videos show up as thumbnails.
-- If you hover the mouse over a thumbnail, the image will show in the preview area (B4).
-- Right mouse click an image for further options such as Open, Save as, Copy, Delete, Delete All.
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b)	Take Photo 
•	 Adjust the microscope so that the camera lens (A7) is close to and pointing at the object.
•	 Make sure the object to be examined is centered under the lens.
•	 While observing the image preview area (B4), bring the image into focus.

•	 To capture the image select the camera shortcut  icon, or press the snapshot button.
•	 Photos will be stored in File > Photos Folder.

	 Captured images show as thumbnails in the saved images window (B7). If you hover the mouse over a 
thumbnail, the image will show in the preview window. Images are stored in the JPG format.

c)	Record Videos
•	 Adjust the microscope so that the camera lens (A7) is close to and pointing at the object.
•	 Make sure the object to be examined is centered under the lens.
•	 While observing the image preview area (B4), bring the image into focus.

•	 To start recording click on the Video shortcut .The icon will flash to indicate recording has started.
•	 Click the flashing icon to stop recording.
•	 Videos will be stored in File > Videos Folder.

	 Captured videos show as thumbnails in the saved images window (B7). If you hover the mouse over a 
thumbnail, the image will show in the preview window. Videos are stored in the AVI format.

d)	Photo and Video Timer

.

•	 You can set a custom start and stop timer for capturing photos or recording 
video.

•	 Select the Timer shortcut , then choose Photo or Video.
•	 Set your desired parameters.
•	 Select Start, to begin recording.

	 Recording will stop after the program has run through the parameters, 
or if you select Stop to end the timer.
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e)	Image Measuring Tools
	 For measuring tools to be accurate, first calibrate your microscope. See section “Calibrating Microscope” 

for information about how to do this.

	 Double-click an image in the saved images window (B7) to enter the measurement interface, then select 
the measure  icon.

•	 Any Angle Line Measurement. Click and drag from one point to another.
•	 Continuous Line Measurement. Click and drag from one point to multiple 

points.
•	 Radius Circle Measurement. Click and drag to extend the radius.
•	 Diameter Circle Measurement. Click and drag to extend the diameter.
•	 Three Points Angle Measurement. Click and drag from one point to 

another, measure the angle, then click the mouse to release. 

f)	 Draw and Text
	 Double-click an image in the saved images window (B7) to enter the Image Markup / Comment interface, 

then select the draw  icon.
•	 A dropdown menu will show with various options.

•	 Line Properties include Line Width and Line Color.

•	 Select the text  icon.
•	 A dropdown menu will show with various options such as font selection and 

text color.
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14.	Calibrating the Microscope
•	 Focus the microscope on the calibration ruler.
•	 Rotate the fine focus dial until the picture becomes sharp. 

•	 Adjust the microscope position so the image is lined 
up square with the XY guides.

	 Double-click an image in the saved images window (B7) to enter the measurement interface, then select 
the calibration  icon.

•	 Click and drag to select start and end points across 
a known value e.g. 1 mm increment along the ruler.

•	 When the dialog box shows, enter the exact value of 
the measurement sample in the Actual dimension 
field. The software will calibrate the magnification. 

•	 Select OK to confirm. The adjusted magnification 
value will show in the upper right corner.

15.	High and Low Magnification
•	 High magnification (1.5 mm field of view): Turn the fine focus dial (A6) all the way to the right, then slowly dial back 

until the image comes into focus.
•	 Low magnification (6 mm field of view): Turn the fine focus dial (A6) all the way to the right, then slowly dial back 

until the image comes into focus.

	 After turning the fine focus dial (A6) all the way right or left, it will take a few seconds for the LED light 
balance to adjust.
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16.	Care and Cleaning
•	 Disconnect the product from your computer before each cleaning. If it is hot, wait for it to cool down.
•	 Do not use any aggressive cleaning agents, rubbing alcohol or other chemical solutions as they can cause damage 

to the housing and malfunctioning.
•	 The LED lights are not replaceable.
•	 Avoid touching the lens with any substance. Clean the lens periodically with low pressure compressed air.
•	 Clean the product with a dry, fibre-free cloth.

17.	Disposal
	 Electronic devices are recyclable and must not be disposed of in the household waste. At the end of its 

service life, dispose of the product in accordance with applicable regulatory guidelines. You thus fulfill your 
statutory obligations and contribute to the protection of the environment.

18.	Technical Data
Operating voltage..............................................5 V/DC, 1 A (via USB 2.0)
Connection........................................................USB 2.0 (Type A)
Image sensor.....................................................5 MP (true)
Video / still capture resolution............................2592x1944, 2320x1744,2048x1536,1920x1080, 1280x1024 Pixel
Focus range.......................................................0 mm to 150 mm (manual focus)
Magnification.....................................................10x - 300 x
Image format.....................................................JPG
Video format......................................................AVI
White balance....................................................Automatic
Light Source......................................................LED
Operating conditions..........................................0 to +70 °C; 25 - 50 % relative humidity (non-condensing)
Storage conditions.............................................-5 to +50 °C; 25 - 50 % relative humidity (non-condensing)
Supported operating systems............................Windows® 7/8/10; Mac OS 10.12 or above
Dimensions camera (Ø x L)...............................33 mm x 110 mm
Dimensions stand (L x W x H)...........................165 x 118 x 12 mm 
Weight................................................................1 kg
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1.	Introduction
Cher client,
Nous vous remercions d'avoir fait l'acquisition de ce produit.
Ce produit est conforme aux exigences nationales et européennes en vigueur.
Afin de garder ce statut et maintenir un fonctionnement correct, vous devez, en tant qu’utilisateur, respecter les 
instructions contenues dans ce mode d’emploi !

	 Ce mode d’emploi est inclus dans le produit. Il contient des informations importantes sur la mise en service 
et la manipulation de l’appareil. Prenez-le également en considération si vous transmettez l’appareil à un 
tiers. Par conséquent, conservez ce mode d’emploi pour toute référence ultérieure !

Pour toute question technique, veuillez vous adresser à:
France (email):	 technique@conrad-france.fr
Suisse:	 www.conrad.ch
	 www.biz-conrad.ch

2.	Explication des symboles
	 Le symbole avec le point d’exclamation dans un triangle  est utilisé pour indiquer les informations 

importantes présentes dans ce mode d’emploi. Veuillez lire ces informations attentivement.

	 Le symbole de la flèche indique des informations spécifiques et des conseils spéciaux pour le 
fonctionnement. 

3.	Utilisation prévue
Le produit offre une image agrandie qui s’affiche sur votre ordinateur via un port USB 2.0 et est idéal pour examiner 
des objets solides tels que les pièces de monnaie, les poinçons, les roches, les insectes, les plantes, les textiles, les 
circuits imprimés, etc. Les voyants LED intégrés à intensité variable fournissent de la luminosité et le logiciel inclus 
permet à l'utilisateur de calibrer le microscope, de modifier et de mesurer la taille des images enregistrées. 
Ce produit est prévu pour un usage à l’intérieur exclusivement. Ne l'utilisez pas à l’extérieur ! Tout contact avec 
l'humidité, par ex. dans les salles de bains, doit être évité en toutes circonstances.
Pour des raisons de sécurité et d’homologation, toute restructuration et/ou modification du produit est interdite. 
Le produit pourrait être endommagé en cas d'utilisation autre que celle décrite ci-dessus. En outre, une mauvaise 
utilisation vous expose à d’autres risques. Lisez attentivement les instructions du mode d’emploi et conservez-le dans 
un endroit sûr ! Si vous donnez l'appareil à une autre personne, donnez-lui également le mode d’emploi.
Tous les noms d’entreprises et appellations de produits sont des marques commerciales de leurs propriétaires 
respectifs. Tous droits réservés
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4.	Contenu d'emballage
•	 Unité de base avec câble USB
•	 Base
•	 CD d’installation du logiciel
•	 Règle de calibrage
•	 Guide de démarrage rapide
•	 Informations importantes
•	 Mode d’emploi

Mode d'emploi actualisé            
Téléchargez la dernière version du mode d'emploi sur www.conrad.com/downloads ou scannez le 
code QR. Suivez les instructions figurant sur le site Web.

5.	Caractéristiques et fonctions
•	 Grossissement variable x 20 - 300
•	 Caméra : 5,0 mégapixels (réel)
•	 Plage de mise au point 10-100 mm 
•	 Fréquence d’images par seconde : 30 ips
•	 8 voyants LED / luminosité réglable (500 lux max.)
•	 Compatible avec Windows® et Mac OS
•	 Logiciel : MicroCapture Plus

6.	Exigences du système
•	 SE : Windows® 7/8/10 ; Mac OS 10.12 ou version supérieure
•	 Unité centrale : Pentium 300 ou processeur AMD compatible 
•	 100 Mo d’espace libre sur le disque dur
•	 512 Mo de RAM
•	 Carte vidéo de 24 bits
•	 Port USB 2.0 disponible
•	 Lecteur CD-ROM
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7.	Consignes de sécurité
Lisez attentivement les informations importantes et les instructions d’utilisation, et respectez 
surtout les consignes de sécurité. Nous ne saurions être tenus pour responsables des blessures 
corporelles ou des dommages matériels résultant du non-respect des mises en garde et des 
indications relatives à une utilisation correcte figurant dans ce mode d'emploi. Le droit à la 
garantie s'annule dans de tels cas.

a)	Généralités
•	 Cet appareil n'est pas un jouet. Il doit rester hors de portée des enfants et des animaux domestiques.
•	 Ne laissez pas traîner le matériel d'emballage. Celui-ci peut se révéler dangereux si des enfants le 

prennent pour un jouet.
•	 Gardez le produit à l’abri de températures extrêmes, de la lumière directe du soleil, de chocs violents, de 
l’humidité élevée, de gaz inflammables, de la vapeur et de solvants.

•	 N’exposez pas le produit à des contraintes mécaniques.
•	 Si vous n'êtes plus en mesure d'utiliser le produit en toute sécurité, arrêtez de l'utiliser et protégez-le 

contre toute utilisation accidentelle. Le produit ne peut plus être utilisé en toute sécurité lorsqu'il :
-- présente des traces de dommages visibles, 
-- ne fonctionne plus normalement, 
-- a été stocké pendant une période prolongée dans des conditions défavorables ou 
-- a été transporté dans des conditions très rudes.

•	 Manipulez le produit avec précaution. Les chocs, les impacts ou même une chute d'une hauteur 
modérée peuvent endommager le produit.

•	 Respectez également les consignes de sécurité et le mode d’emploi de tout autre appareil que vous 
connectez à ce produit.

•	 Si vous avez des doutes concernant le fonctionnement, la sécurité ou le raccordement de l’appareil, 
consultez un expert.

•	 Toute opération d’entretien, de modification et de réparation doit être effectuée uniquement par un 
technicien ou un centre de réparation agréé.

•	 Si vous avez des questions qui sont restées sans réponse après avoir lu toutes les instructions 
d'utilisation, contactez notre service de support technique ou un autre technicien spécialisé.

•	 Attention, éclairage à LED !
-- Ne regardez pas directement la lumière produite par les diodes LED !
-- Ne regardez pas le faisceau directement ou avec des instruments optiques !

•	 Dans les écoles, les établissements de formation, les ateliers de loisir ou de libre service, l’utilisation des 
appareils électriques doit être surveillée par un personnel formé.

•	 L'utilisation dans les établissements commerciaux doit être conforme à la réglementation pertinente 
des commissions des accidents de travail en matière de prévention des accidents de travail liés aux 
équipements électriques.
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b)	Microscope
•	 Évitez d'examiner des objets lorsque la température est inférieure ou supérieure à la plage de 

température de fonctionnement normale du produit.
•	 En cas de variation brusque de température causée notamment par une entrée dans une pièce chaude 
en hiver, de l’humidité pourrait s’infiltrer dans le microscope. Gardez-le dans un sac à main ou un sac en 
plastique pour ralentir les variations de température.

•	 Ne dirigez pas l’objectif du microscope vers le soleil ou une forte lumière pendant longtemps. Un 
éclairage puissant pourrait endommager les composants électroniques sensibles à la lumière.

•	 N’usez pas de la force pour introduire la carte dans la fente, car cela pourrait endommager le microscope 
et la carte mémoire micro SD. 

•	 La base du microscope peut laisser des marques sur les surfaces sensibles.

c)	Câble
•	 En installant le produit, assurez-vous que le câble ne soit ni pincé, ni noué et qu'il ne puisse pas être 

endommagé en passant sur des bords tranchants.
•	 Placez toujours les câbles de sorte que personne ne puisse trébucher par dessus ou s'emmêler dedans. 

Ceci présente un risque de blessures.

d)	Protection contre la poussière
•	 La poussière et les déchets présents dans l’air peuvent entraîner la détérioration de la qualité de l’image. 

Gardez le microscope en dehors des environnements poussiéreux.
•	 L’ouverture de l’objectif de la caméra doit être toujours protégée à l’aide de housses. Les protections 

appropriées incluent les feuilles d'aluminium et les sacs en plastique.
•	 Si vous remarquez des points noirs ou des objets au point similaire sur les images numériques, et qui 

ne se trouvent pas sur le plan de l’échantillon, la cause la plus probable serait la contamination du 
capteur d’image ou de la surface du filtre associée par des particules. Les caméras doivent toujours être 
manipulées avec le plus grand soin et protégées des impuretés selon les recommandations du fabricant.

•	 Avant chaque utilisation critique, vérifiez s’il n'y a pas de saleté sur la partie avant de l’objectif.
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8.	Éléments d'utilisation
A1

A2

A3 A4 A6

A5

A7
A8

A10

A11

A12
A13

A9

A1	 Guide-câble USB
A2	 Dispositif de réglage de luminosité des voyants LED
A3	 Dispositif de verrouillage de la mise au point grossière
A4	 Molette de mise au point grossière
A5	 Système de verrouillage du support pour microscope
A6	 Molette de mise au point fine
A7	 Source d’éclairage à LED / objectif de la caméra

A8	 Platine avec pinces
A9	 Câble USB 2.0 de type-A
A10	 Dispositif de verrouillage pour réglage de la hauteur 

du bras
A11	 Colonne
A12	 Vis de fixation de la colonne
A13	 Base

9.	Mise en place du microscope
	 Sortez délicatement le microscope de son emballage et placez-le sur une surface plane et stable. La base 

du support peut laisser des marques sur les surfaces sensibles. Assurez-vous que la colonne (A11) est 
complètement insérée et fixée à l'aide de la vis de fixation de la colonne (A12).
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10.	Mise au point du microscope
	 Ne couvrez pas le microscope lorsqu’il est en service.

•	 Placez l'objet à examiner sur la platine (A8). S’il y a des lames ou des objets similaires, glissez-les sous les pinces 
de platine. 

•	 Tout en maintenant la molette de mise au point grossière en place (A4), relâchez le dispositif de verrouillage de la 
mise au point grossière (A3).

•	 Tournez la molette de mise au point grossière (A4) pour abaisser l'objectif vers l'objet.
•	 Réglez la molette de mise au point fine (A6) pour rendre l’image nette.
•	 Selon la taille de l'objet, vous devrez peut-être ajuster la hauteur du bras en libérant le verrou de réglage de la 

hauteur du bras (A10), en ajustant la position, puis en la resserrant.

	 Il faudra peut-être attendre quelques minutes pour que l’équilibre des blancs s’ajuste de manière 
automatique et rende l’image nette. Si les faisceaux réfléchis par l’objet sont forts, envisagez de baisser la 
luminosité du voyant LED (A2) ou de l'éteindre complètement.
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11.	Connexion du microscope à l’ordinateur
•	 Connectez le câble USB 2.0 du microscope (A9) à un port USB 2.0 disponible sur votre ordinateur.
•	 Rangez le câble en le clipsant au guide-câble USB (A1).

12.	Installation du logiciel
a)	Windows®

•	 Insérez le disque d’installation dans le lecteur DVD-ROM de votre ordinateur.
•	 Sélectionnez l’option MicroCapture Plus pour installer le logiciel, puis suivez les instructions qui s’affichent sur 

l'écran pour terminer le processus d'installation.
•	 Exécutez le logiciel en cliquant sur l'icône MicroCapture Plus générée sur le bureau après l'installation.

	 Changez la langue d’affichage si nécessaire p. ex., Options > Language (Langue) > English (Anglais).

b)	Mac OS
•	 Insérez le disque d’installation dans le lecteur DVD-ROM de votre ordinateur.
•	 Cherchez le dossier Mac sur le disque d’installation. 
•	 Sélectionnez le fichier MicroCapture Plus.pkg.
•	 Suivez les instructions à l'écran pour terminer la procédure d'installation.
•	 Exécutez le logiciel en cliquant sur l'icône MicroCapture Plus générée sur le bureau après l'installation.

	 Changez la langue d’affichage si nécessaire p. ex., Options > Language (Langue) > English (Anglais).
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13.	Logiciel MicroCapture Plus
a)	Vue d’ensemble

B1
B2

B3

B4

B5

B6

B7

B1	 Éléments du menu
-- File (Fichier) > Photos ou Videos Folder (Dossier Photos ou Vidéos) : Emplacement des images capturées.
-- Options > Resolution (Résolution) : Modifiez la résolution de la capture d’image.
-- Options > Date /Time (Date /Heure) : Affichez/masquez la date et l’heure de l’enregistrement sur la photo ou 

la vidéo.
-- Options > Language (Langue) : Modifiez la langue de l’interface utilisateur.
-- Options > XY Guide (Guide XY) : Affichez/masquez les lignes de guidage.

B2	 Raccourcis : Caméra / Vidéo / Minuteur / Plein écran.

 
Accédez au mode plein écran ou quittez-le en double-cliquant sur la zone de prévisualisation ou en cliquant sur 
l’icône du plein écran.

B3	 Lignes guides des axes X et Y.
B4	 Zone de prévisualisation des images.
B5	 Informations sur le grossissement.
B6	 Onglet Photo / Vidéo : Sélectionnez un onglet pour visualiser les Photos ou Vidéos enregistrées.
B7	 Fenêtre des images enregistrées (vue miniature).

-- Les images capturées ou les vidéos enregistrées s’affichent en miniature.
-- Si vous placez le curseur de la souris sur une miniature, l'image apparaîtra dans la zone de prévisualisation (B4).
-- Faites un clic droit sur l’image pour avoir plus d’options, notamment Open (Ouvrir), Save as (Enregistrer sous), 

Copy (Copier), Delete (Supprimer), Delete All (Supprimer tout).
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b)	Prise de photo 
•	 Réglez le microscope de manière à rapprocher l’objectif de la caméra (A7) de l’objet et à l’orienter vers celui-ci.
•	 Assurez-vous que l'objet à examiner est placé au centre, en dessous de l'objectif.
•	 Tout en observant la zone de prévisualisation des images (B4), effectuez la mise au point de l'image.

•	 Pour capturer l'image, sélectionnez l'icône  de raccourci de la caméra ou appuyez sur le bouton de capture 
instantanée.

•	 Les photos seront enregistrées à l’emplacement File (Fichier) > Photos Folder (Dossier des Photos).

	 Les images capturées s’affichent en miniature dans la fenêtre des images enregistrées (B7). Si vous 
placez le curseur de la souris sur une miniature, l'image apparaîtra sur la fenêtre de prévisualisation. Les 
images sont enregistrées en format JPG.

c)	Enregistrement des vidéos
•	 Réglez le microscope de manière à rapprocher l’objectif de la caméra (A7) de l’objet et à l’orienter vers celui-ci.
•	 Assurez-vous que l'objet à examiner est placé au centre, en dessous de l'objectif.
•	 Tout en observant la zone de prévisualisation des images (B4), effectuez la mise au point de l'image.

•	 Pour lancer l'enregistrement, cliquez sur l’icône de raccourci des vidéos . L'icône clignote pour indiquer que 
l'enregistrement a démarré.

•	 Cliquez sur l’icône qui clignote pour arrêter l’enregistrement.
•	 Les vidéos seront sauvegardées à l’emplacement File (Fichier) > Videos Folder (Dossier des Vidéos).

	 Les vidéos enregistrées s’affichent en miniature dans la fenêtre des images enregistrées (B7). Si vous 
placez le curseur de la souris sur une miniature, l'image apparaîtra sur la fenêtre de prévisualisation. Les 
vidéos sont enregistrées en format AVI.

d)	Minuterie de prise de photos et de vidéos

.

•	 Vous pouvez définir une minuterie de démarrage et d’arrêt personnalisée pour 
capturer des photos ou enregistrer des vidéos.

•	 Sélectionnez le raccourci de la Minuterie  puis choisissez une Photo ou 
une Videos (Vidéos).

•	 Définissez les paramètres souhaités.
•	 Sélectionnez Start (Démarrer) pour lancer l’enregistrement.

	 L’enregistrement s’arrêtera une fois que le programme aura parcouru 
les paramètres, ou si vous sélectionnez Stop (Arrêter) pour arrêter la 
minuterie.
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e)	Outils de mesure de la taille des images
	 Afin que les outils de mesure soient fiables, calibrez d’abord votre microscope. Voir section « Calibrage du 

microscope » pour plus d'informations sur la manière de procéder.

	 Double-cliquez sur une image dans la fenêtre des images enregistrées (B7) pour accéder à l’interface de 
mesure, puis sélectionnez l'icône  de mesure.

•	 Any Angle Line Measurement (Mesure de toutes les lignes des angles). 
Cliquez et faites glisser le curseur d’un point à l’autre.

•	 Continuous Line Measurement (Mesure de lignes continues). Cliquez et 
faites glisser le curseur d’un point à plusieurs points.

•	 Radius Circle Measurement (Mesure du cercle de rayon). Cliquez et 
faites glisser le curseur pour élargir le rayon.

•	 Diameter Circle Measurement (Mesure du diamètre du cercle). Cliquez 
et faites glisser le curseur pour augmenter le diamètre.

•	 Three Points Angle Measurement (Mesure d’angle à trois points). 
Cliquez et faites glisser le curseur d’un point à un autre, mesurez l’angle puis 
cliquez pour relâcher. 

f)	 Dessins et textes
	 Double-cliquez sur une image dans la fenêtre des images enregistrées (B7) pour accéder à l’interface de 

marquage des images ou de commentaires, puis sélectionnez l’icône  de dessin.
•	 Un menu déroulant affiche différentes options.

•	 Line Properties (Les Propriétés de lignes) incluent la Line Width (Largeur 
de la ligne) et la Line Color (Couleur de la ligne).

•	 Sélectionnez l’icône  de texte.
•	 Un menu déroulant proposera différentes options telles que la sélection de 

polices et la couleur de texte.



40

14.	Calibrage du microscope
•	 Dirigez le microscope vers la règle de calibrage.
•	 Tournez la molette de mise au point fine jusqu'à ce que l'image soit 

nette. 

•	 Ajustez la position du microscope de manière à 
aligner l'image avec les guides XY.

	 Double-cliquez sur une image dans la fenêtre des images enregistrées (B7) pour accéder à l'interface de 
mesure, puis sélectionnez l'icône  de calibrage.

•	 Cliquez et faites glisser le curseur pour sélectionner 
le point de départ et le point final à travers une valeur 
connue, par ex., l’incrément de 1 mm le long de la règle.

•	 Lorsque la boîte de dialogue s’ouvre, entrez la 
valeur exacte de l’échantillon de mesure dans le 
champ Actual dimension (Dimension actuelle). 
Le logiciel calibrera le grossissement. 

•	 Cliquez sur OK pour confirmer. La valeur de 
grossissement ajustée apparaîtra dans le coin 
supérieur droit.

15.	Fort ou faible grossissement
•	 Fort grossissement (champ de vision de 1,5 mm) : Tournez complètement la molette de mise au point fine (A6) vers 

la droite, puis tournez-la lentement dans l’autre sens jusqu'à ce que l'image soit nette.
•	 Faible grossissement (champ de vision de 6 mm) : Tournez complètement la molette de mise au point fine (A6) vers 

la droite, puis tournez-la lentement dans l’autre sens jusqu'à ce que l'image soit nette.

	 Après avoir tourné complètement la molette de mise au point fine (A6) vers la droite ou la gauche, il faudra 
attendre quelques secondes pour que le contraste des voyants LED s’ajuste.
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16.	Entretien et nettoyage
•	 Déconnectez le produit de votre ordinateur avant de le nettoyer. S’il chauffe, attendez qu’il se refroidisse.
•	 N'utilisez pas de produits de nettoyage abrasifs, d'alcool à frictionner ou autre produit chimique : ceux-ci risqueraient 

d'abîmer le boîtier et de causer des dysfonctionnements.
•	 Les voyants LED ne sont pas remplaçables.
•	 Évitez de toucher l’objectif avec une substance quelconque. Nettoyez régulièrement l’objectif avec de l’air comprimé 

à basse pression.
•	 Nettoyez le produit avec un tissu sec, non pelucheux.

17.	Recyclage
	 Les appareils électroniques sont recyclables et ne doivent pas être jetés dans les ordures ménagères. En 

fin de vie, éliminez l’appareil conformément aux dispositions légales en vigueur. Ainsi, vous respectez les 
ordonnances légales et contribuez à la protection de l’environnement.

18.	Données techniques
Tension de service.............................................5 V/CC, 1 A (via câble USB 2.0)
Connexion.........................................................port USB 2.0 (Type A)
Capteur d’images..............................................5 MP (réel)
Résolution vidéo /  
de capture des images fixes..............................�2592 x 1944, 2320 x 1744, 2048 x 1536, 1920 x 1080, 

1280 x 1024 pixels
Plage de mise au point......................................0 à 150 mm (mise au point manuelle)
Grossissement...................................................x 10 à 300
Format d’image..................................................JPG
Format vidéo......................................................AVI
Équilibre de blancs............................................Automatique
Source d’éclairage.............................................LED
Conditions de fonctionnement...........................0 à +70 °C; 25 à 50 % d’humidité relative (sans condensation)
Conditions de stockage.....................................-5 à +50 °C; 25 à 50 % d’humidité relative (sans condensation)
Systèmes d'exploitation pris en charge.............Windows® 7/8/10 ; Mac OS 10.12 ou version supérieure
Dimensions de la caméra (Ø x L)......................33 x 110 mm
Dimensions du support (L x l x H).....................165 x 118 x 12 mm 
Poids..................................................................1 kg
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1.	Introductie
Geachte klant,
Hartelijk bedankt voor het aanschaffen van dit product.
Het product is in overeenstemming met de nationale en Europese wettelijke voorschriften.
Om deze status in stand te houden en veilig gebruik te waarborgen, dient u als de gebruiker deze gebruiksaanwijzingen 
in acht te nemen!

	 Deze gebruiksaanwijzingen maken deel uit van dit product. Ze bevatten belangrijke informatie over 
inbedrijfstelling en hantering. Houd hier ook rekening mee als u het product aan derden overhandigt. 
Bewaar deze gebruiksaanwijzingen dus ter referentie!

Bij technische vragen kunt u zich wenden tot onze helpdesk.Voor meer informative kunt u kijken op www.conrad.nl 
of www.conrad.be

2.	Verklaring van de Symbolen
	 Dit symbool met het uitroepteken in een driehoek wordt gebruikt om belangrijke informatie in deze 

gebruiksaanwijzing te onderstrepen. Lees deze informatie altijd aandachtig door.

	 Het pijlsymbool duidt op speciale informatie en advies voor het gebruik. 

3.	Beoogd Gebruik
Het is uiterst geschikt voor het onderzoeken van solide voorwerpen zoals munten, postzegels, gesteente, insecten, 
planten, textiel, printplaten, enz. Dimbare LED-lampjes bieden helderheid en u kunt de gebundelde software gebruiken 
om de microscoop te ijken en opgeslagen afbeeldingen te meten. 
Dit product is alleen bedoeld voor gebruik binnenshuis. Gebruik het niet buitenshuis. Contact met vocht, bijv. in de 
badkamer, moet absoluut worden vermeden.
Op veiligheids- en goedkeuringsgronden moet u dit apparaat niet verbouwen en/of wijzigen. Als het product voor 
andere doeleinden wordt gebruikt dan hierboven beschreven kan het worden beschadigd. Bovendien kan onjuist 
gebruik tot andere gevaren leiden. Lees de gebruiksaanwijzing goed door en bewaar deze op een veilige plek. Het 
product mag alleen samen met de gebruiksaanwijzing aan derden ter hand worden gesteld.
Alle bedrijfs- en productnamen zijn handelsmerken van de betreffende eigenaren. Alle rechten voorbehouden.
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4.	Leveringsomvang
•	 Hoofdeenheid met USB-kabel
•	 Basis
•	 Software-cd
•	 Liniaal voor ijking
•	 Snelstarthandleiding
•	 Belangrijke informatie
•	 Gebruiksaanwijzing

Meest recente gebruiksaanwijzing           
Download de meest recente gebruiksaanwijzing via www.conrad.com/downloads of scan de 
afgebeelde QR-code. Volg de aanwijzingen op de website.

5.	Eigenschappen en Functies
•	 20x - 300x variabele vergroting
•	 Camera: 5,0 megapixels (echt)
•	 Focusbereik 10 - 100 mm 
•	 Videoframesnelheid 30 fps
•	 8 x LED/verstelbare helderheid (max. 500 lux)
•	 Compatibel met Windows®, Mac OS
•	 Software: MicroCapture Plus

6.	Systeemvereisten
•	 OS: Windows® 7/8/10; Mac OS 10.12 of hoger
•	 CPU: Pentium 300 of compatibele AMD-processor 
•	 100 MB vrije ruimte op de harde schijf
•	 512 MB RAM
•	 24-bit videokaart
•	 Beschikbare USB 2.0-poort
•	 CD-ROM-drive
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7.	Veiligheidsinstructies
Lees zorgvuldig alle belangrijke informatie en gebruiksaanwijzingen en let voornamelijk 
op de veiligheidsinformatie. Indien de veiligheidsinstructies en de aanwijzingen voor een 
juiste bediening in deze gebruiksaanwijzing niet worden opgevolgd, aanvaarden wij geen 
verantwoordelijkheid voor hieruit resulteren persoonlijk letsel of materiële schade. In dergelijke 
gevallen vervalt de aansprakelijkheid/garantie.

a)	Algemeen
•	 Dit apparaat is geen speelgoed. Houd het buiten het bereik van kinderen en huisdieren.
•	 Laat verpakkingsmateriaal niet achteloos rondslingeren. Dit kan voor kinderen gevaarlijk speelgoed worden.
•	 Bescherm het product tegen extreme temperaturen, direct zonlicht, krachtige stoten, hoge 

luchtvochtigheid, vocht, ontvlambaar gas, stoom en oplosmiddelen.
•	 Stel het product niet bloot aan mechanische druk.
•	 Als het product niet langer veilig gebruikt kan worden, stel het dan buiten bedrijf en zorg ervoor dat niemand 

het per ongeluk kan gebruiken. Veilig gebruik kan niet langer worden gegarandeerd als het product:
-- zichtbaar is beschadigd, 
-- niet meer naar behoren werkt, 
-- voor langere duur is opgeslagen onder slechte omstandigheden, of 
-- onderhevig is geweest aan ernstige transportbelasting.

•	 Behandel het product met zorg. Schokken, stoten of zelfs een val van geringe hoogte kunnen het 
product beschadigen.

•	 Let bovendien op de veiligheids- en gebruiksaanwijzingen van andere apparatuur aangesloten op het product.
•	 Raadpleeg een expert wanneer u twijfelt over het gebruik, de veiligheid of de aansluiting van het 

apparaat.
•	 Onderhoud, modificaties en reparaties mogen alleen worden uitgevoerd door een technicus of 

geautoriseerd onderhoudscentrum.
•	 Als u nog vragen hebt die niet in deze gebruiksaanwijzing zijn beantwoord, neem dan contact op met 

onze technische dienst of ander technisch personeel.
•	 Let op, LED-lamp:

-- Niet rechtstreeks in de LED-lamp kijken!
-- Niet direct of met optische instrumenten in de lichtstraal kijken!

•	 Het hanteren van elektrische apparaten in scholen, trainingscentra, hobby of zelfservice werkplaatsen 
moet worden overzien door getraind personeel.

•	 Wanneer gebruikt in commerciële gebouwen, dan moeten de regelgevingen inzake ongevallenpreventie 
van de raad voor arbeiderscompensatie in acht worden genomen.



46

b)	Microscoop
•	 Onderzoek geen voorwerpen met temperaturen buiten het gespecificeerde bereik voor de 

bedrijfstemperatuur van het product.
•	 Plotselinge temperatuurschommelingen kunnen dauw vormen binnenin de microscoop, zoals wanneer 

u vanuit koud weer een warme kamer binnenloopt. Plaats het in een handtas of plastic zak om 
temperatuurschommelingen te vertragen.

•	 Richt de microscooplens niet langdurig op de zon of krachtige lichten. Krachtig licht kan de lichtgevoelige 
elektronica beschadigen.

•	 Steek de kaart niet geforceerd in de MicroSD-kaartsleuf (A4) om beschadiging van de microscoop en 
geheugenkaart te voorkomen. 

•	 De basis van de microscoop kan markeringen achterlaten op gevoelige oppervlaktes.

c)	Kabel
•	 Zorg er tijdens het plaatsen van het product voor dat de kabel niet bekneld raakt, verbogen of door 

scherpe randen beschadigd wordt.
•	 Leg kabels altijd zo, dat niemand erover kan struikelen of erin verstrikt kan raken. Er bestaat risico op 

verwondingen.

d)	Bescherming Tegen Stof
•	 Stof en vuil uit de lucht kunnen tot verslechtering van de beeldkwaliteit leiden. Houd de microscoop uit 
de buurt van stoffige omgevingen.

•	 De opening van de cameralens dient altijd te worden bescherming met stofcovers, e.d. Geschikte opties 
zijn o.a. aluminiumfolie of plastic zakjes.

•	 Als u donkere stippen of soortgelijke in-focus artefacten opmerkt in digitale beelden, en deze vallen 
buiten de mogelijkheden van het exemplaar, dan ligt dit zeer waarschijnlijk aan verontreiniging door 
deeltjes op de beeldsensor of op een geassocieerd filteroppervlak. De camera's dienen altijd uiterst 
voorzichtig te worden gehanteerd en beschermd tegen vuil volgens de aanbevelingen van de fabrikant.

•	 Voorafgaand aan elk kritiek gebruik, controleer de voorlens van het doel op vuil.
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8.	Bedieningselementen
A1

A2

A3 A4 A6

A5

A7
A8

A10

A11

A12
A13

A9

A1	 USB-kabelhouder
A2	 Afstelling LED-helderheid
A3	 Ruwe focusvergrendeling
A4	 Ruwe focusschijf
A5	 Vergrendeling microscoophouder
A6	 Fijne focusschijf
A7	 LED-lichtbron / cameralens

A8	 Platform met platformklemmen
A9	 USB 2.0 Type-A kabel
A10	 Vergrendeling voor verstelling armhoogte
A11	 Kolom
A12	 Bevestigingsschroef kolom
A13	 Basis

9.	De Microscoop Instellen
	 Haal de microscoop voorzichtig uit de verpakking en plaats deze op een stabiel en vlak oppervlak. De basis 

van de steun kan markeringen achterlaten op gevoelige oppervlaktes. Zorg ervoor dat de kolom (A11) 
volledig is ingestoken en goed vast zit met de bevestigingsschroef van de kolom (A12).
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10.	De Microscoop Scherpstellen
	 De microscoop niet bedekken wanneer in gebruik.

•	 Plaats het te onderzoeken exemplaar op het platform (A8). Als u dia's of iets dergelijks bekijkt, steek deze dan 
onder de platformklemmen. 

•	 Houd de ruwe focusschijf op zijn plek (A4) en ontgrendel gelijkertijd de ruwe focusvergrendeling (A3).
•	 Draai de ruwe focusschijf (A4) om de lens richting het exemplaar te laten zakken.
•	 Pas de fijne focusschijf (A6) aan om het beeld in scherpe focus te brengen.
•	 U dient afhankelijk van de afmeting van het exemplaar misschien de armhoogte aan te passen door de vergrendeling 

voor verstelling van de armhoogte te ontgrendelen (A10), de positie aan te passen en deze vervolgens weer vast 
te zetten.

	 Het kan eventjes duren totdat de witbalans het beeld automatisch aanpast en in focus brengt. Als het 
exemplaar teveel reflecteert, probeer dan de LED-helderheid (A2) te verlagen of volledig uit te schakelen.
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11.	De Microscoop Aansluiten op een Computer
•	 Sluit de USB 2.0 microscoopkabel (A9) aan op een beschikbare USB 2.0-poort op uw computer.
•	 U kunt de losse kabel netjes opruimen door deze in de USB-kabelhouder (A1) te klemmen.

12.	Software-installatie
a)	Windows®

•	 Plaats de installatieschijf in de DVD-ROM-drive van uw computer.
•	 Selecteer MicroCapture Plus om de software te installeren en volg vervolgens de instructies op het scherm om 

het installatieproces af te ronden.
•	 Start de software door op het icoontje MicroCapture Plus te klikken dat na de installatie op het bureaublad is 

geplaatst.
	 Verander eventueel de weergavetaal via Options (Opties) > Language (Taal) > English (Engels).

b)	Mac OS
•	 Plaats de installatieschijf in de DVD-ROM-drive van uw computer.
•	 Zoek naar de map op de installatieschijf met de naam Mac. 
•	 Selecteer het bestand MicroCapture Plus.pkg.
•	 Volg de instructies op het scherm om het installatieproces af te ronden.
•	 Start de software door op het icoontje MicroCapture Plus te klikken dat na de installatie op het bureaublad is 

geplaatst.
	 Verander eventueel de weergavetaal via Options (Opties) > Language (Taal) > English (Engels).
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13.	MicroCapture Plus Software
a)	Overzicht

B1
B2

B3

B4

B5

B6

B7

B1.	Menu-onderwerpen
-- File (Bestand) > Photos or Videos Folder (Foto's of Video's Folder): Locatie van opgenomen afbeeldingen.
-- Options (Opties) > Resolution (Resolutie): De resolutie veranderen voor beeldopnames.
-- Options (Opties) > Date/Time (Datum/Tijd): De opgenomen datum en tijd in foto's of video's weergeven/

verbergen.
-- Options (Opties) > Language (Taal): De taal van de gebruikersinterface veranderen.
-- Options (Opties) > XY Guide (XY Richtlijnen): Richtlijnen weergeven/verbergen.

B2.	Snelkoppelingen: Camera/Video/Timer/Volledig Scherm.

 
Open of verlaat de volledige schermmodus door te dubbelklikken op het voovertoningsgedeelte of door het 
volledige schermicoontje te selecteren.

B3.	X- en Y-as richtlijnen.
B4.	Voorvertoningsgedeelte voor afbeeldingen.
B5.	Vergrotingsinformatie.
B6.	Tabblad Foto/Video: Selecteer een tabblad om uw opgeslagen Foto's of video's te bekijken.
B7.	Venster voor opgeslagen afbeeldingen (miniatuuroverzicht).

-- Opgenomen foto's / video's worden as miniaturen weergegeven.
-- Als u de muis over een miniatuur beweegt, dan zal de afbeelding worden weergegeven in het 

voorvertoningsgedeelte (B4).
-- Klik met de rechter muisknop op een afbeelding voor meer opties, zoals Open (Openen), Save as(Opslaan als), 

Copy (Kopiëren), Delete (Wissen), Delete All (Alles Wissen).
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b)	Foto's Nemen 
•	 Pas de microscoop zodanig aan dat de cameralens (A7) dicht bij en op het exemplaar gericht is.
•	 Zorg ervoor dat het te onderzoeken exemplaar in het midden onder de lens ligt.
•	 Terwijl het beeld in het voorvertoningsgedeelte (B4), brengt u het beeld in focus.

•	 Selecteer het snelkoppelingsicoontje Camera  of druk op de momentopnametoets.
•	 Foto's worden opgeslagen in File (Bestand) > Photos Folder (Foto's Folder).

	 Opgenomen afbeeldingen worden als miniaturen weergegeven in het venster voor opgeslagen 
afbeeldingen (B7). Als u de muis over een miniatuur beweegt, dan zal de afbeelding worden weergegeven 
in het voorvertoningsvenster. Afbeeldingen worden opgeslagen in het formaat JPG.

c)	Video's Opnemen
•	 Pas de microscoop zodanig aan dat de cameralens (A7) dicht bij en op het exemplaar gericht is.
•	 Zorg ervoor dat het te onderzoeken exemplaar in het midden onder de lens ligt.
•	 Terwijl het beeld in het voorvertoningsgedeelte (B4), brengt u het beeld in focus.

•	 Selecteer het snelkoppelingsicoontje Video . Het icoontje zal knipperen om aan te geven dat de opname is 
gestart.

•	 Klik op het knipperende icoontje om de opname te stoppen.
•	 Video's worden opgeslagen in File (Bestand) > Videos Folder (Video's Folder).

	 Opgenomen video's worden als miniaturen weergegeven in het venster voor opgeslagen afbeeldingen 
(B7). Als u de muis over een miniatuur beweegt, dan zal de afbeelding worden weergegeven in het 
voorvertoningsvenster. Video's worden opgeslagen in het formaat AVI.

d)	Foto- en Videotimer

.

•	 U kunt uw eigen start- en stoptimer instellen voor het maken van foto's of 
opnemen van video's.

•	 Selecteer de snelkoppeling Timer  en selecteer vervolgens Photos (Foto) 
of Video.

•	 Stel de gewenste parameters in.
•	 Selecteer Start om de opname te starten.

	 De opname zal stoppen nadat het programma de parameters heeft 
doorlopen of als u Stop selecteert om de timer te eindigen.
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e)	Meetapparatuur voor Afbeeldingen
	 U dient de microscoop eerst te ijken zodat de meetapparatuur nauwkeurig is. Raadpleeg paragraaf “De 
Microscoop IJken” voor informatie over hoe dit gebeurt.

	 Dubbelklik op een afbeelding in het venster met opgeslagen afbeeldingen (B7) om de meetinterface te 
openen en selecteer vervolgens het meeticoontje .

•	 Any Angle Line Measurement. (Lijnmeting vanuit een Willekeurige 
Hoek). Klik en sleep van het ene naar het andere punt.

•	 Continuous Line Measurement (Continue Lijnmeting). Klik en sleep van 
het ene punt naar meerdere punten.

•	 Radius Circle Measurement (Meting met Radiuscirkel). Klik en sleep om 
de radius te vergroten.

•	 Diameter Circle Measurement (Meting met Diametercirkel). Klik en sleep 
om de diameter te vergroten.

•	 Three Points Angle Measurement (Hoekmeting met Drie Punten). Klik en 
sleep van het ene naar het andere punt, meet de hoek en klik vervolgens op 
de muis om los te laten. 

f)	 Tekenen en Tekst
	 Dubbelklik op een afbeelding in het venster met opgeslagen afbeeldingen (B7) om de interface 

Beeldmarkering/Aantekeningen te openen en selecteer vervolgens het tekenicoontje .
•	 Er zal een menu uitklappen met verschillende opties.

•	 Line Properties (Lijneigenschappen) bevat Line Width (Lijnbreedte) en 
Line Color (Lijnkleur).

•	 Selecteer het teksticoontje .
•	 Er zal een menu uitklappen met verschillende opties zoals selectie van de 

lettergrootte en tekstkleur.
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14.	De Microscoop IJken
•	 Focus de microscoop op de ijkliniaal.
•	 Draai de fijne focusschijf totdat het beeld scherp wordt. 

•	 Pas de positie van de microscoop aan zodat het beeld 
recht afgestemd is op de XY-richtlijnen.

	 Dubbelklik op een afbeelding in het venster met opgeslagen afbeeldingen (B7) om de meetinterface te 
openen en selecteer vervolgens het ijkicoontje .

•	 Klik en sleep om de start- en eindpunten te 
selecteren over een bekende waarde, bijv. 1 mm 
toename over de liniaal.

•	 Wanneer het dialoogvenster verschijnt, voer dan de 
exacte waarde in van het gemeten monster in het 
veld Actual dimension (Actuele afmeting). De 
software zal de vergroting kalibreren. 

•	 Selecteer ter bevestiging OK. De aangepaste 
vergrotingswaarde zal rechtsboven in de hoek 
worden weergegeven.

15.	Hoge en Lage Vergroting
•	 Hoge vergroting (1,5 mm gezichtsveld): Draai de fijne focusschijf (A6) volledig naar rechts en draai de schijf 

vervolgens geleidelijk aan terug totdat het beeld in focus komt.
•	 Lage vergroting (6 mm gezichtsveld): Draai de fijne focusschijf (A6) volledig naar rechts en draai de schijf 

vervolgens geleidelijk terug totdat het beeld in focus komt.

	 Het zal enkele seconden duren totdat de LED-lichtbalans is afgesteld nadat u de fijne focusschijf (A6) 
volledig naar rechts of links hebt gedraaid.



54

16.	Onderhoud en reiniging
•	 Ontkoppel het product van uw computer voorafgaand aan elke reiniging. Als het heet is, wacht totdat het is afgekoeld.
•	 Gebruik in geen geval agressieve schoonmaakmiddelen, reinigingsalcohol of andere chemische oplossingen 

omdat deze schade aan de behuizing of storingen kunnen veroorzaken.
•	 De LED-lampjes kunnen niet worden vervangen.
•	 Laat de lens met geen enkele substantie in contact komen. Reinig de lens af en toe met perslucht op lage druk.
•	 Reinig het product met een droog, pluisvrij doekje.

17.	Verwijdering
	 Elektronische apparaten zijn recyclebaar en mogen niet als huishoudelijk afval worden afgevoerd. Als 

het product niet meer werkt moet u het volgens de geldende wettelijke bepalingen voor afvalverwerking 
afvoeren. Op deze wijze voldoet u aan uw wettelijke verplichtingen en draagt u bij aan de bescherming van 
het milieu.

18.	Technische gegevens
Bedrijfsspanning................................................5 V/DC, 1 A (via USB 2.0)
Aansluiting.........................................................USB 2.0 (Type A)
Beeldsensor.......................................................5 MP (waar)
Opnameresolutie video/stilstaand beeld................2592 x 1944, 2320 x 1744,2048 x 1536,1920 x 1080, 1280 x 1024 Pixel
Focusbereik.......................................................0 mm tot 150 mm (handmatige focus)
Vergroting..........................................................10x - 300 x
Fotoformaat.......................................................JPG
Videoformaat.....................................................AVI
Witbalans...........................................................Automatisch
Lichtbron............................................................LED
Bedrijfscondities................................................0 tot +70; 25 - 50 % relatieve vochtigheid (zonder condens)
Opslagcondities.................................................-5 tot +50; 25 - 50 % relatieve vochtigheid (zonder condens)
Ondersteunde besturingssystemen...................Windows® 7/8/10; Mac OS 10.12 of hoger
Afmetingen camera (Ø x L)...............................33 mm x 110 mm
Afmetingen steun (L x B x H).............................165 x 118 x 12 mm 
Gewicht..............................................................1 kg
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